
Installation Guide

PowerDesigner® 16.1

Windows



DOCUMENT ID: DC38092-01-1610-02
LAST REVISED: June 2012
Copyright © 2012 by Sybase, Inc. All rights reserved.
This publication pertains to Sybase software and to any subsequent release until otherwise indicated in new editions or
technical notes. Information in this document is subject to change without notice. The software described herein is furnished
under a license agreement, and it may be used or copied only in accordance with the terms of that agreement.
Upgrades are provided only at regularly scheduled software release dates. No part of this publication may be reproduced,
transmitted, or translated in any form or by any means, electronic, mechanical, manual, optical, or otherwise, without the prior
written permission of Sybase, Inc.
Sybase trademarks can be viewed at the Sybase trademarks page at http://www.sybase.com/detail?id=1011207. Sybase and
the marks listed are trademarks of Sybase, Inc. ® indicates registration in the United States of America.
SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered
trademarks of SAP AG in Germany and in several other countries all over the world.
Java and all Java-based marks are trademarks or registered trademarks of Oracle and/or its affiliates in the U.S. and other
countries.
Unicode and the Unicode Logo are registered trademarks of Unicode, Inc.
All other company and product names mentioned may be trademarks of the respective companies with which they are
associated.
Use, duplication, or disclosure by the government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of DFARS
52.227-7013 for the DOD and as set forth in FAR 52.227-19(a)-(d) for civilian agencies.
Sybase, Inc., One Sybase Drive, Dublin, CA 94568.

http://www.sybase.com/detail?id=1011207


Contents

CHAPTER 1: Planning Your PowerDesigner
Installation ....................................................................1

Obtaining a License ...............................................................4
Installing a License Server ...................................................4

Adding Additional Licenses with lmtools .........................7
Troubleshooting with lmutil ..............................................8
SySAM for IPv6 Environments ........................................8
SySAM for 64-Bit and Non-Windows Environments .......8

Upgrading PowerDesigner ....................................................9
Downloading Sybase EBFs and Maintenance Reports ....10
Windows 64-Bit Support .....................................................10
Password and Data Encryption ..........................................11

CHAPTER 2: Installing PowerDesigner .......................13
Installing PowerDesigner in Administrative Mode ...........17

Creating the Administrative Install on the Server ..........18
Installing Client Machines .............................................18
Upgrading an Administrative Install ..............................19

Installing PowerDesigner in Silent Mode ...........................19
Uninstalling PowerDesigner in Silent mode ..................20

Uninstalling PowerDesigner and Installation
Maintenance .....................................................................21

Manual Fonts Installation ....................................................22
PowerDesigner Dependencies ...........................................22

CHAPTER 3: Installing the Repository ........................23
Installing and Authenticating SQL Anywhere ...................24

Creating a Database to Contain the Repository ...........25

Installation Guide iii



Installing the Repository to the Server ..............................26
Creating a Data Source to Access Your Database .......28
Troubleshooting the Repository Installed on ASE .........29
Troubleshooting the Repository Installed on DB2 .........30
Troubleshooting the Repository Installed on SQL

Server .......................................................................30
Installing the Repository Proxy ..........................................31
Installing the PowerDesigner Portal Server ......................33

Accessing the PowerDesigner Portal Web Site ............37
Controlling SSL Encryption for the PowerDesigner

Portal ........................................................................38
Installing the PowerDesigner Portal Server on UNIX ....39
Multiple PowerDesigner Portal Instances on One

Server ......................................................................40
Changing the Repository DBMS ...................................41

Upgrading the Repository ...................................................41
Post-Upgrade Cleanup for a Repository Containing

Branches ..................................................................43
Deleting the Repository ......................................................44

Index ...........................................................................................45

Contents

iv PowerDesigner



CHAPTER 1 Planning Your PowerDesigner
Installation

The deployment of PowerDesigner® typically involves the installation of a license server, one
or more repository components, and a number of client machines.

A PowerDesigner environment can contain the following servers, components, and client
machines:

• PowerDesigner server components (enclosed in the dotted line box) - Can all be installed
on a single server or on separate servers as necessary to maximize performance:
• SySAM Server - Required if using served or floating licenses.
• Repository Server - Required if using the repository.
• Proxy Server - Required if using the repository proxy.
• Portal Data Server - Required if using the PowerDesigner Portal.
• Portal Web Server - Required if using the PowerDesigner Portal.

• Local servers - PowerDesigner can connect to these servers in your local environment:
• LDAP Server - to delegate the authentication of repository users.
• SMTP Server - to automate the sending of email notifications.

• Client machines - Allow users to access the repository using the following applications:
• PowerDesigner Client - Can access the repository directly or through the proxy.
• Web Browser - Can access the repository through the PowerDesigner Portal.
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Note: For installation of PowerDesigner without a repository, complete steps one and two of
this procedure and then go directly to Chapter 2, Installing PowerDesigner on page 13.

1. Obtain your license key file (see Obtaining a License on page 4).

If you do not have a license key, you will only be able to install PowerDesigner for a 15-day
trial period.

2. Install the Sysam license server (see Installing a License Server on page 4).

The license server is required if you intend to share served licenses among users instead of
assigning individual licenses per machine.

3. Install PowerDesigner on the administrator's workstation (see Chapter 2, Installing
PowerDesigner on page 13).

This initial installation is needed to install the PowerDesigner repository, which is used to
store and share models.

4. Choose a server capable of supporting large, long-running transactions to host your
repository. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on your DBMS, the number of concurrent users,
and the size of your repository.

Note: To calculate the size required for your repository database, estimate the number of
models that will be stored and the period during which they will be developed. An average
model containing 100 primary objects (tables, classes, etc.) will have an initial disk size of
5MB and the size of its initial check in will be around 10MB. Assuming an average number
of edits, each subsequent check in will add 10% to the size of the file, so that after an
average development period of two months (40 working days) with one check in per day,
the final model file size will be 10MB*1.140 or approximately 500MB. If your team will
develop 20 such models during the course of the year, you should allow 10GB of space for
your repository database.

If you want to use the repository proxy or PowerDesigner Portal, you should install them,
by preference, on the same machine where the repository is located to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing these
components on another machine on the same LAN segment.

5. Install SQL Anywhere® on the repository server and create a database to house the
PowerDesigner repository (see Installing and Authenticating SQL Anywhere on page
24) .

Alternatively, create a database to house the repository in one of the other supported
DBMSs:
• Adaptive Server® Enterprise
• Oracle 8 and higher
• IBM DB2 Common Server and DB2 for OS/390
• Informix 2000
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• Microsoft SQL Server 2005 and higher - we recommend that you
use a server that is not currently managing a high transaction load,
since PowerDesigner performs long- running synchronous transactions during Check-
In/Check-Out.

Note: The most up-to-date list of supported DBMSs, is available at http://
certification.sybase.com.

6. Install the repository to the new database (see Installing the Repository to the Server on
page 26).

7. [optional] Install the repository proxy on the repository server (see Installing the
Repository Proxy on page 31).

The proxy simplifies and offers more security for connection to your repository and may
provide performance improvements in environments where clients will be connecting
over a WAN or complicated LAN or when dealing regularly with large (15MB+) models.

8. [optional] Install the PowerDesigner Portal on the repository server (see Installing the
PowerDesigner Portal Server on page 33).

The PowerDesigner Portal provides access to your repository models via a Web browser.

9. Define a password policy, optionally connect to an LDAP server to delegate the
authentication of repository users and an SMTP server for notifications, and create groups
and user accounts with appropriate rights and permissions to control access to the
repository (see Core Features Guide > Administering PowerDesigner > Controlling
Repository Access).

10. [optional] Customize the PowerDesigner interface to optimize it for various groups of
users and define shared reference models and resources:

• Prepare profiles to customize the PowerDesigner interface (by hiding types of models,
objects, and properties and customizing menus, toolbars, and settings) and associate
them with appropriate users and groups (see Core Features Guide > Administering
PowerDesigner > Customizing the PowerDesigner Interface).

• Prepare shared reference models and an enterprise glossary for deployment to users
(see Core Features Guide > Administering PowerDesigner > Deploying an Enterprise
Glossary and Library).

• Prepare custom resource files (such as DBMSs, languages, and extensions) for
deployment to users (see Core Features Guide > Administering PowerDesigner >
Deploying an Enterprise Glossary and Library > Deploying an Enterprise Library >
Sharing Resource Files via the Library).

11. Install PowerDesigner on user machines (see Chapter 2, Installing PowerDesigner on page
13).

Note: If you are not using the repository proxy, you will also need to install the SQL
Anywhere client (as part of the PowerDesigner installation) or an appropriate client or
driver for your chosen DBMS on all client machines to allow them to connect to the
repository.
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Obtaining a License
When you purchase SySAM 2–enabled Sybase® products, you must generate, download, and
deploy SySAM product licenses.

• If you purchased your product from Sybase or an authorized Sybase reseller, go to the
secure Sybase Product Download Center (SPDC) at https://sybase.subscribenet.com and
log in to generate license keys. The license generation process may vary slightly,
depending on whether you ordered directly from Sybase or from a Sybase reseller.

• If you ordered your product under an SAP® contract and were directed to download from
SAP Service Marketplace (SMP), you can use SMP at http://service.sap.com/licensekeys
to generate license keys for Sybase products that use SySAM 2-based licenses.

Host ID
To obtain a license, you must know the host ID and name of the computer that will act as the
license server. You can obtain these values during installation of SYSAM on the third page of
the installation program where you are asked to load or copy a license file to proceed. Ethernet
addresses are 12 character hex values consisting of digits 0 through 9 and characters A through
F, which can be entered in any of the following formats:

• 12AB34CD56EF
• 12-AB-34-CD-56-EF
• 12:AB:34:CD:56:EF

Your host id is obtained by entering the first 8 characters of the ethernet address in one of the
following formats:

• 12AB34CD
• 12AB-34CD

Note: For some platforms, host IDs can also be entered in decimal formats, with a # prefix.
Example: #1039716963

For Windows platforms, if your machine does not have a network adapter, you can use the disk
serial number as an alternate host ID. Use the lmutil lmhostid -vsn command or
execute DIR C: to obtain the serial number, remove the hyphen and enter it with a
DISK_SERIAL_NUM= prefix. For example: DISK_SERIAL_NUM=3e2e17fd

Installing a License Server
If you intend to use standalone served or floating served licenses, you must either install the
SySAM license server provided as part of the PowerDesigner installation or locate an existing
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SySAM license server on your network, to which your PowerDesigner licenses can be
assigned.

The license server serves a license to a user upon request and retrieves it when it is no longer
being used. If all the licenses are already in use, the license server informs you that no license
is available.

You must already have obtained a license file before you can install the license server (see 
Obtaining a License on page 4).

Note: Do not install a license server and PowerDesigner on the same workstation. License
servers installed with PowerDesigner v11 are not compatible with v12.0 and higher. If you no
longer use PowerDesigner v11, we recommend that you uninstall the old license server.

If you borrow a mobile license and your workstation has installed other products with Flexlm
served licenses, you may encounter problems returning your license to the server.

1. Select the machine on which you want to install the SySAM license server (this should not
be a workstation on which you will install any Sybase product), and insert the
PowerDesigner CD.

2. Click the Install Licenses Server button to open the Sybase Software Asset Management
Installshield wizard:

CHAPTER 1: Planning Your PowerDesigner Installation
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3. Click Next to display the license agreement page. Read the License Agreement and click
the I Agree radio button to accept the terms of the agreement. If you click I Do Not Agree,
the installation will be cancelled.

4. Click Next to display the license file definition page. Click the Load button and browse to
the folder where your license file is located. The content of the license file is automatically
displayed in the License key box.
If you do not have a license file, see Obtaining a License on page 4.

5. Click Next to display the destination folder page. Select the suggested installation
directory or browse to a new one and then click Next to go to the settings page.

6. Click Next to accept the current settings and start copying files.

The copy starts. A progress box is displayed and Setup copies files to the destination
directory. When installation is complete:
• If SySAM had to be installed, you can choose to start the license server as a service.
• If the PowerDesigner licenses were assigned to an existing license server, you can

choose to reread the licenses to refresh the server license file.

7. Click Finish to exit the wizard.

Note: If a firewall is activated on the computer where the license server is installed, then
the ports 27000 and 27010 must be opened in the firewall. For a Windows Firewall, you
may need to add the port 27000 and the SySAM executable (for example C:\Sybase
\SYSAM-2_1\Bin\SYBASE.exe to the list of exceptions.
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Additionally, on Windows and UNIX platforms, edit the license server license files to add
the port number 27000 to the line beginning SERVER and add a new line VENDOR
SYBASE PORT=27010 directly after it. When you have finished, these lines should read
as follows:
SERVER server_name server_id 27000
VENDOR SYBASE PORT=27010

Adding Additional Licenses with lmtools
The license server should configure itself correctly at installation. If you need to subsequently
add additional licenses or otherwise administer the server, you can do so using lmtools.exe

1. Double-click SYSAM-x_x\Bin\lmtools.exe to open the LMTOOLS dialog.

2. On the Service/License File tab, select SYSAM in the list of servers:

3. Click the Start/Stop/Reread tab and click the Reread License File button to force the
server to read again the file sybpdes.lic and update license number.

4. Select File > Exit to close the LMTOOLS dialog.

For detailed information about lmtools, follow the SySAM Documentation Collection link
available at http://www.sybase.com/sysam.
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Troubleshooting with lmutil
lmutil.exe, which is available in the SYSAM-x_x\Bin folder provides various diagnostic
possibilities.

For example, the following command can be used to find the user(s) who have currently
borrowed the license(s):

lmutil lmstat -a -c <port>@<host> where <port> and <host> are license 
server information.

For detailed information about lmutil, follow the SySAM Documentation Collection link
available at http://www.sybase.com/sysam.

SySAM for IPv6 Environments
By default, the 32-bit Windows version of SySAM for IPv4 is provided in the PowerDesigner
setup. You can add IPv6 support easily after installation by copying the appropriate
executables in the installation directory.

1. Open SYSAM-x_x\Bin\lmtools.exe and click the Start/Stop/Reread tab.

2. Select the SYSAM server in the list and click Stop Server (you may need to select the Force
Server Shutdown check box if licenses are currently being borrowed).

3. Open the folder SYSAM-x_x\Bin\binIPv6, and copy the files lmgrd.exe and
SYBASE.exe to SYSAM-x_x\Bin, overwriting the existing versions.

4. Return to the Start/Stop/Reread tab in the LMTOOLS dialog, and click Start Server.

SySAM for 64-Bit and Non-Windows Environments
You can obtain a SySAM server for 64-bit Windows or for a non-Windows environment from
the Sybase website.

Note: The 32-bit version of SySAM will run on a 64-bit Windows machine, but if you prefer to
install a 64-bit version, you can download it from the Sybase website.

To download a 64-bit version of SySAM for Windows or a SySAM server for a non-Windows
environment, go to http://www.sybase.com/sysam, select SySAM Standalone License
Servers, and follow the download instructions.

Note: Any licenses that have been activated for a Windows server must be reactivated for any
other platform.
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Upgrading PowerDesigner
This topic provides guidance on issues relating to Office add-ins, the license server, and
resource files, which may arise when upgrading PowerDesigner.

• Repository branches - Prior to v16.1, the repository browser only supported displaying a
single branch at a time. When you upgrade an existing repository to v16.1, all branches
will become, by default, visible for all users. You may wish to simplify viewing the
repository by deleting documents and branches that are no longer used, by using
permissions to hide certain branches from users or groups who have no need of them, or by
migrating active models to a new repository (see Post-Upgrade Cleanup for a Repository
Containing Branches on page 43).

• Office add-ins - Though PowerDesigner v15.x and v16.x can be installed together on the
same workstation, after the installation of v16.x, the add-ins supporting importing from
MS Word and Visio will only function for v16.x.

• License Server - In general, you can serve licenses for clients using PowerDesigner v15.x
and v16.x from the same SySAM license server. However, if you want to support
heterogeneous versions of the Data Architect package (which is only available as an
upgrade to v16.x and not as a new purchase), you will need to install a second license
server on another machine and plan to serve the licenses associated with each version from
a separate server.

• Resource Files - DBMS and language definition files and other resource files provided
with PowerDesigner are constantly evolving. If you have not edited the resource files
delivered with a previous version of PowerDesigner, then the upgrade to the latest version
will happen silently.
If you have edited a definition file or other resource file from a previous version, then it will
continue to work with the new version. However, we advise you to use the Compare tool
to review the differences between your file and the file delivered with the new version and,
if appropriate, merge them to obtain bug fixes or new features. For information about
comparing and merging resource files, see Customizing and Extending PowerDesigner >
PowerDesigner Resource Files.
If you have stored resource files from a previous version in the repository then you must
check them in again under the new version before you can continue to use them. Resource
files can now be stored in the library and pushed to users (see Core Features Guide >
Administering PowerDesigner > Deploying an Enterprise Glossary and Library >
Deploying an Enterprise Library > Sharing Resource Files via the Library).
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Downloading Sybase EBFs and Maintenance Reports
Get EBFs and maintenance reports from the Sybase Web site or the SAP® Service
Marketplace (SMP). The location you use depends on how you purchased the product.

• If you purchased the product directly from Sybase or from an authorized Sybase
reseller:

a) Point your Web browser to http://www.sybase.com/support.
b) Select Support > EBFs/Maintenance.
c) If prompted, enter your MySybase user name and password.
d) (Optional) Select a filter, a time frame, or both, and click Go.
e) Select a product.

Padlock icons indicate that you do not have download authorization for certain EBF/
Maintenance releases because you are not registered as an authorized support contact.
If you have not registered, but have valid information provided by your Sybase
representative or through your support contract, click My Account to add the
“Technical Support Contact” role to your MySybase profile.

f) Click the Info icon to display the EBF/Maintenance report, or click the product
description to download the software.

• If you ordered your Sybase product under an SAP contract:

a) Point your browser to http://service.sap.com/swdc.
b) Select Search for Software Downloads and enter the name of your product. Click

Search.

Windows 64-Bit Support
PowerDesigner is only available in a 32-bit version, but installation on 64-bit versions of
Windows is supported.

To ensure that PowerDesigner can communicate with your data sources, you should use the
32-bit version of the ODBC Administrator tool. PowerDesigner cannot connect to 64-bit
ODBC DSNs. For detailed information about working with 32-bit DSNs on a 64-bit version of
Windows, see http://support.microsoft.com/kb/942976.
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Password and Data Encryption
PowerDesigner supports encryption of both passwords and data for direct and proxy
connections to a repository and for connections to other databases using most of the supported
DBMSs via one or more of native, ODBC, and JDBC connection profiles.

The following table provides information and examples for encrypting passwords and data
with each type of connection:

Type Encryption

Native Password and data encryption can generally be enabled with connection param-
eters.

For example, the password for Sybase Adaptive Server Enterprise is encrypted
by default, and you can enable data encryption by setting the Sec_Confi-
dential connection parameter to 1.

ODBC Password and data encryption can generally be enabled in the ODBC Configu-
ration dialog.

For example, to encrypt the password for Sybase SQL Anywhere, select the
Encrypt password option on the Login tab, and to encrypt data, select an en-
cryption method on the Network tab.

JDBC It is not possible to control password and data encryption through the Power-
Designer connection profile interface, but you may be able to enable encryption
directly in your database client.

For more information about using PowerDesigner connection profiles, see Core Features
Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner > Connecting
to a Database. For detailed information about encryption and other parameters for your
database, see your DBMS documentation.

CHAPTER 1: Planning Your PowerDesigner Installation
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CHAPTER 2 Installing PowerDesigner

You can install PowerDesigner directly on individual client machines, including as a plugin
for the Eclipse and Visual Studio IDEs. You can also perform a mass silent installation or an
administrative installation to a network server.

Note: You should obtain a license key (see Obtaining a License on page 4) and, if appropriate,
install and configure your license server (see Installing a License Server on page 4) before
beginning.

PowerDesigner has the following minimum system requirements:

• Microsoft Windows XP, Vista, or 7 or Microsoft Windows Server 2003 or 2008
• 1.5 GHz processor
• 1 GB RAM (2 GB recommended)
• SVGA or higher-resolution graphics adapter and compatible color monitor (800x600)
• CD-ROM drive
• 1GB disk space for installation of all the core modules (and demonstration videos).

For information about the frameworks and libraries and frameworks required by
PowerDesigner, see PowerDesigner Dependencies on page 22.

Note: Non-Administrator users may receive a warning message during installation as setup
requires write access on certain directories and on the registry that they may not have. Setup
can go on despite this message.

1. Insert the PowerDesigner CD-ROM in your drive.

If setup does not automatically start, then double-click the SETUP.EXE file in the setup
directory of the CD-ROM.

2. Click the Install PowerDesigner 16.1 button to open the welcome page, and then click
Next to go to the license selection page.

3. Select one of the following license types:

• Trial version – is a full-featured version, valid for an evaluation period of 15 days, that
allows you to perform any design task. Contact Sybase if you require a limited
extension.

• Local standalone license – is installed on and locked to a particular machine. Click
Next to go to the license key page, where you must load a valid license file (see 
Obtaining a License on page 4).

• Served standalone license – is provided by one or more SySAM license servers, and is
locked to a particular machine. Click Next to go to the license server page, where you
must enter the name of your license server.
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• Served floating license – is provided by one or more SySAM license servers, which
manage the allocation and recuperation of licenses among a pool of users. Click Next
to go to the license server page, where you must enter the name of your license server.

For more information about PowerDesigner licensing, see Core Features Guide >
Modeling with PowerDesigner > Getting Started with PowerDesigner > License
Management.

4. [for served licenses] Click Next to go to the package selection page, where you can select
which package to install. The list displays all the packages that are available on the server
but it does not necessarily reflect the current availability of a license for a particular
package.

5. Click Next to go to the license agreement page. Select the location where you are installing
the software, read the License Agreement, and then click the I Agree radio button to accept
the terms of the agreement. If you click I Do Not Agree, you cannot proceed with the Setup
program.

Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

6. Click Next to go to the directory selection page. Accept the default installation directory or
choose another by clicking the Browse button.

We recommend that you do not install a new major version of PowerDesigner in a
directory that holds a previous version.

7. Click Next to go to the component selection page, which lists the products and features
that are available to install. Each node can be expanded in order to let you select or deselect
sub-features:
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Note:
• The PowerDesigner plugin for Eclipse is available for Eclipse v3.2 to v3.6. For more

information, see Core Features Guide > Modeling with PowerDesigner > The
PowerDesigner Plugin for Eclipse.

• The PowerDesigner add-in for Microsoft Visual Studio and Team Foundation is
available for Visual Studio 2005, 2008, and 2010. For more information, see Core
Features Guide > Modeling with PowerDesigner > The PowerDesigner Add-In for
Visual Studio.

• The SQL Anywhere drivers provide connectivity to a repository installed on SQL
Anywhere, which is bundled with PowerDesigner (see Installing and Authenticating
SQL Anywhere on page 24).

Select or clear check boxes as necessary, and then click Next.

8. If you selected the Eclipse 3 plug-in in the list of components, the Eclipse directory
selection page is displayed. Click the Browse button to specify a directory containing a
valid Eclipse installation.

Note: If you had manually installed the Eclipse plug-in in PowerDesigner version 10 or 11
and want to upgrade to version 16.x you have to remove the plug-in manually. To do so,
open the Eclipse directory, and remove any PowerDesigner-related folder under the
\configuration, \features, and \workspace\.metadata\.plugins folders.

CHAPTER 2: Installing PowerDesigner
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9. Click Next to go to the user profiles page. Select the user profiles that you want to apply
immediately to your installation.

Note that whatever you select on this page, all the profiles will be installed and you can
apply any profiles after installation. If you select two or more contradictory profiles (for
example, E/R Notation and Barker Notation, in the CDM category), the one that appears
last in the list will be applied:

For more information about user profiles, including how to make your own profiles
available to the installer, see Core Features Guide > Modeling with PowerDesigner >
Customizing Your Modeling Environment > User Profiles.

10. Click Next to go to the program folders page. You can select to make PowerDesigner
available from the default folder or select or create another.

11. Click Next to go to the current settings page, which lists all your selections. Select the
Keep PowerDesigner Settings check box to retain any settings from a previous version of
PowerDesigner.

Note: For new major versions, even if you select to retain settings from a previous version,
resource file named paths (such as _DBMS) pointing inside the Resource Files
directory inside the PowerDesigner installation will be updated to point to the new
installation directory in order for you to benefit from bug fixes and other improvements. If

CHAPTER 2: Installing PowerDesigner

16 PowerDesigner



you have defined additional paths for populating your resource file lists, these will not be
affected.

12. Click Next to begin the install. Setup begins copying files to the destination directory.

13. Wait for the setup to complete, and then click Finish to exit the wizard. Depending on your
working environment, you may be prompted to reboot your machine.

Note: The Readme.html file, which contains important release information, is
available in the root of your installation directory.

Installing PowerDesigner in Administrative Mode
System administrators can install PowerDesigner on a server and have client machines run the
application from this central install. The client machines do not install any files but their
registry is modified in order to be able to access PowerDesigner from the specified location.

With this type of administrative mode install, there is only one instance of PowerDesigner to
deploy and upgrade.

You can install any type of PowerDesigner license and specify any combination of installation
options on each client machine.

CHAPTER 2: Installing PowerDesigner
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Creating the Administrative Install on the Server
The first part of the administrative install consists in copying the PowerDesigner files to a
server. You are not required to enter any product key or select any feature to install. All
PowerDesigner setup files are decompressed and copied to the server, but the server registry
and system files will not be affected.

1. Insert the CD-ROM in the drive to automatically launch the setup program. The initial
setup dialog box is displayed. Click the Administrative Installation button.

or

Select Start > Run, type the PowerDesigner setup.exe path followed by /a in the Run
dialog box and click OK.

The welcome page is displayed.

2. Click Next to display the network location page.

3. Specify the network location where you want to copy the product files, and then click
Install.

The setup status page displays a progress box while the files are copied to the destination
directory. When this process is complete, the complete page opens.

4. Click Finish to exit the InstallShield Wizard.

Installing Client Machines
Once you have created the administrative install on the server, you can set up the client
machines. The client install modifies the registry of the client machine in order to be able to
reference the files located on the server, but does not copy any file onto the client machine.
Consequently no space is required on the client machine.

1. On the client machine, open Windows Explorer, connect to the network location where
you have created the administrative install and double-click the Setup.exe file.

The welcome page is displayed.

2. Click Next to open the license selection page, select a license type, and then click Next
again.
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3. Define the appropriate installation parameters on the following pages, and then click
Finish to begin the install.

Depending on your working environment, Setup may ask you to reboot your machine.

Upgrading an Administrative Install
You can pass the administrative install command to an upgrade package downloaded from the
web.

Note: You cannot upgrade between major versions. Each major version (12.x, 15.x, etc.) must
be installed as a new administrative install in its own directory.

Use the following syntax to upgrade your administrative install to a new minor version:
upgrade_package.exe /a

Installing PowerDesigner in Silent Mode
If you need to deploy PowerDesigner on a large number of machines and wish to reuse exactly
the same setup options and destination folder for each machine, you can use the silent install
mode. Silent install runs without user input, by using a response file (called setup.iss) that
specifies all the required installation options.

The silent installation mode does not provide any information about the installation itself. You
can open the setup.log file in the directory containing the setup.exe file to have a report
about the silent install. The last section of this ResponseResult file contains a line
ResultCode=X. If X=0, installation was successful.

Note: You can perform a silent install from the product CD or from a network location where
the PowerDesigner installation files have been copied (see Creating the Administrative Install
on the Server on page 18).

1. To create a setup.iss response file, select Start > Run to open the Windows Run dialog box
and enter the following command:

<PD-inst-dir>\setup\setup.exe /r /f1"<path>\setup.iss"

Complete the installation parameters as required and then click Finish to create the
setup.iss file at <path>. For example, the following:

G:\setup\setup.exe /r /f1"setup.iss"

References a network drive G:, mapped to a location where the PowerDesigner files have
been copied, and creates setup.iss in the setup directory for easy access.

2. Proceed to install the client machine with the following command:

<PD-inst-dir>\setup\setup.exe /s /f1"<path>\setup.iss".

Each new silent install will replace the content of the setup.log file located in the
Installation drive.
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Use the /f2 parameter to define a local directory where the setup.log file will be stored on
each client machine:

G:\setup\setup.exe /s /f2"c:\temp\setup.log"

Note: From a client machine, map a drive to the server where the PowerDesigner files are
copied. The drive letter must be the same as that on the server. For example, if your
PowerDesigner files are located on drive R:\admin\setup.exe, you must use the R drive on
each client machine to access installation files.

Uninstalling PowerDesigner in Silent mode
A silent uninstall works in a similar fashion to the silent install, but requires that you locate the
InstallShield PowerDesigner maintenance file.

For PowerDesigner v16.x this file is located, by default, at:
C:\Program Files\InstallShield Installation Information\{D88DF8F0-
B749-4D26-AFBC-A6E588099793}\setup.exe

Note: It may be that your maintenance file is not found in the standard location. You can
always retrieve its location file from the following registry key: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft \Windows\CurrentVersion\Uninstall\{D88DF8F0-B749-4D26-
AFBC- A6E588099793}

1. To create an uninstall.iss response file, select Start > Run to open the Windows Run
dialog box to invoke the installshield maintenance file with the following options:

<path-to>\setup.exe /r /f1"<path>\uninstall.iss"

Complete the installation parameters as required and then click Finish to create the
uninstall.iss file at <path>. For example, the following:

C:\Program Files\InstallShield Installation Information
\setup.exe /r /f1"C:\temp\uninstall.iss"

Uses the standard maintenance file, and creates uninstall.iss in a temp directory.

2. Proceed to uninstall the client machine with the following command:

<path-to>\setup.exe /s /f1"<path>\uninstall.iss"
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Uninstalling PowerDesigner and Installation Maintenance
After installing PowerDesigner on your machine, you can modify the installation by selecting
Control Panel > Add/Remove Programs or by restarting the installation.

You can:

• Modify - your PowerDesigner installation by adding or removing program features. Select
or clear components in the components page.

• Repair - your PowerDesigner installation by reinstalling it. You must have the installation
CD or access to the network drive where installation files are copied.

• Remove - your installation and clean up your registry.

Note: User files are not removed and you cannot modify your license configuration.
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Manual Fonts Installation
If setup fails to define default fonts, you can do it manually.

1. Select the Fonts page in the General Options dialog box and define fonts for UI, Code and
RTF Editor.

2. Create a new report, select Report > Change Font and define new fonts.

3. Verify that the following registry key does not exist: HKEY_CURRENT_USER\Software
\Sybase\PowerDesigner 16\DisplayPreferences\Font Name.

4. Create a registry key named Font Name (with the following string values: Name, Size,
Style) for all symbols in the following registry key: HKEY_LOCAL_MACHINE
\Software\Sybase\PowerDesigner 16\DisplayPreferences\Font Name.

PowerDesigner Dependencies
PowerDesigner depends on a certain number of frameworks and libraries and will install them
if they are not present in your environment.

• WindowsInstaller-KB893803-v2-x86.exe - to support the installation
of .NET.

• Microsoft .NET Framework 4.0
• Windows Installer 3.1 and Windows Imaging Component - for your Windows version.
• o2003pia.msi, o2007pia.msi, o2010pia.msi - Microsoft Office Primary

Interop Assemblies for MS Office 2003, 2007, and 2010 to support PowerDesigner MS
Office plugins.

• extensibilityMSM.msi - shared Addin Extensibility update for .Net to support
PowerDesigner MS Office plugins.

• msxml6-KB954459-enu-x86.exe - to support the PowerDesigner XSM.

• vjredist.exe - Microsoft Visual J# 2.0 redistribuable to support the PowerDesigner
Auto-Layout feature.

• ProjectAggregator2.msi - to support the PowerDesigner Visual Studio add-in.

• vcredist_x86.exe - Microsoft Visual C++ 2010 Runtime Libraries
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CHAPTER 3 Installing the Repository

The PowerDesigner repository can be used to store your PowerDesigner models and other
files relating to your design projects. An administrator must set up the repository, which is
stored in a database on a server.

For information about using the repository, see Core Features Guide > Storing and Sharing
Models > The Repository.

1. Choose a server capable of supporting large, long-running transactions to host your
repository. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on your DBMS, the number of concurrent users,
and the size of your repository.

Note: To calculate the size required for your repository database, estimate the number of
models that will be stored and the period during which they will be developed. An average
model containing 100 primary objects (tables, classes, etc.) will have an initial disk size of
5MB and the size of its initial check in will be around 10MB. Assuming an average number
of edits, each subsequent check in will add 10% to the size of the file, so that after an
average development period of two months (40 working days) with one check in per day,
the final model file size will be 10MB*1.140 or approximately 500MB. If your team will
develop 20 such models during the course of the year, you should allow 10GB of space for
your repository database.

If you want to use the repository proxy or PowerDesigner Portal, you should install them,
by preference, on the same machine where the repository is located to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing these
components on another machine on the same LAN segment.

2. Install SQL Anywhere® on the repository server and create a database to house the
PowerDesigner repository (see Installing and Authenticating SQL Anywhere on page
24) .

Alternatively, create a database to house the repository in one of the other supported
DBMSs:
• Adaptive Server® Enterprise
• Oracle 8 and higher
• IBM DB2 Common Server and DB2 for OS/390
• Informix 2000
• Microsoft SQL Server 2005 and higher - we recommend that you

use a server that is not currently managing a high transaction load,
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since PowerDesigner performs long- running synchronous transactions during Check-
In/Check-Out.

Note: The most up-to-date list of supported DBMSs, is available at http://
certification.sybase.com.

3. Install the repository to the new database (see Installing the Repository to the Server on
page 26).

4. [optional] Install the repository proxy on the repository server (see Installing the
Repository Proxy on page 31).

The proxy simplifies and offers more security for connection to your repository and may
provide performance improvements in environments where clients will be connecting
over a WAN or complicated LAN or when dealing regularly with large (15MB+) models.

5. [optional] Install the PowerDesigner Portal on the repository server (see Installing the
PowerDesigner Portal Server on page 33).

The PowerDesigner Portal provides access to your repository models via a Web browser.

6. Define a password policy, optionally connect to an LDAP server to delegate the
authentication of repository users and an SMTP server for notifications, and create groups
and user accounts with appropriate rights and permissions to control access to the
repository (see Core Features Guide > Administering PowerDesigner > Controlling
Repository Access).

Installing and Authenticating SQL Anywhere
The PowerDesigner repository is delivered with an authenticated version of Sybase SQL
Anywhere, which can only be used to store your PowerDesigner model repository. Note that
the trial version of PowerDesigner is supplied with a lighter version of SQL Anywhere, for
which the setup may be slightly different.

1. Insert the software CD-ROM in the drive, and click the Install SQL Anywhere button.
Choose your setup language, and then click Next to open the SQL Anywhere InstallShield
wizard.

2. Click Next to go to the license agreement page. Select your country or region, review and
accept the license terms, and then click Next to go to the Custom Setup.

3. Leave all the defaults, click Next, and then click Install to start the installation.

Note: When installing SQL Anywhere on a 64-bit version of Windows, you must install
the 32-bit versions of the database and administration tools (see Windows 64-Bit Support
on page 10).
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4. When the installation is complete, you will be invited to view the ReadMe and online
resources. Make your choices, and then click Finish to exit the wizard

5. Copy the authenticate.sql file delivered in the Setup\support directory of the
installation media (and installed to the Tools directory of your PowerDesigner
installation) to the \Scripts directory in your SQL Anywhere installation on the
repository server.

Copying these statements in this way ensure that when you create a database, it will
automatically be authorized for use with the PowerDesigner repository.

Note: If you create a database before having copied the authentication instructions in this
way, then you will need to authenticate it manually by opening the Interactive SQL tool,
logging into your database, and running the contents of authenticate.sql against
it.

Creating a Database to Contain the Repository
Once you have installed SQL Anywhere, you must create an authenticated database on the
repository server to which you will deploy the repository.

1. Select Start > Programs > SQL Anywhere 12 > Admin Tools > Sybase Central to open
Sybase Central.

2. Select Tools > SQL Anywhere 12 > Create Database to open the Create Database
Wizard.
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3. Click Next to go to the Select a Location page. The Create a database on this computer
option is automatically selected. Click Next to go to the Specify a Database File page.

4. Enter an appropriate name and location for the database, and then click Next to go to the
Specify the Transaction Log File page.

Note: You will need to specify this file when you create a data source to allow
PowerDesigner to connect to the database (see Creating a Data Source to Access Your
Database on page 28).

5. Make sure the Maintain the Following Transaction Log File check box is selected,
accept or specify an alternate log file name and location, and then click Next.

6. Continue clicking Next and accepting the default settings until you arrive at the Specify
DBA User and Password page.

7. By default, the database is created with an administrator account called DBA, and with a
password sql. Select these defaults or enter your own, and then click Next to go to the
Connect to the Database page.

Note: You will need to enter this username and password in the repository definition (see
Installing the Repository to the Server on page 26) and data source (see Creating a Data
Source to Access Your Database on page 28).

8. Deselect the Connect to the new database option, and then click Finish to create the
database.

Installing the Repository to the Server
The repository administrator must set up the repository on a database server running one of the
supported DBMSs.

Note: Before you can install the repository, you must create an empty database with an
administrator user who has full rights on all the tables (see Creating a Database to Contain the
Repository on page 25) and install PowerDesigner on the repository administrator's
workstation (see Chapter 2, Installing PowerDesigner on page 13).

1. On the repository administrator's workstation, start PowerDesigner and select Repository
> Repository Definitions to open the List of Repository Definitions.

2. Click the Add a Row tool to create a new definition, and click the Properties tool to open
its property sheet.

3. Enter the following properties:

Property Value

Repository name Enter an appropriate name to identify the repository.
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Property Value

Data source
name

Click the Select a Data Source tool to the right of the field and select or create
the data source that you want to use to connect to the repository database.

To create an ODBC machine data source for a SQL Anywhere database, see
Creating a Data Source to Access Your Database on page 28. For detailed
information about creating, configuring, and using connection profiles for
other DBMSs, see Core Features Guide > Modeling with PowerDesigner >
Getting Started with PowerDesigner > Connecting to a Database.

User name Enter the administrator name you chose when creating the database.

Password Enter the administrator password you chose when creating the database

Bytes per char For non-Oracle unicode or multi-byte character set databases, specify the
bytes per character used by the database:
• 1-byte - [default] For SBCS (Single-Byte Character Set)
• 2-byte - For DBCS (Double-Byte Character Set)
• 3-byte - For Unicode or MBCS (Multi-Byte Character Set)

4. Click Test to test the connection and, in the event of an error, double-check your
connection parameters. Then click OK to return to your repository definition, and click
OK to complete its creation.

5. Select Repository > Connect to open the Connect dialog. Select the name of the
repository definition you just created and click OK to connect.

A message box is displayed inviting you to install the repository. This will involve running
a SQL script to create the necessary tables.

6. Click Yes to continue. The read-only Repository Installation Script window opens.
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Note: You cannot edit the script in this dialog, but you can, if necessary, modify the
statements (for example, to add physical options) by copying the script to an external SQL
editor, making the appropriate edits, and then connecting to the database to execute the
script outside of PowerDesigner. The Separator list in the dialog lets you select the
separator appropriate to your interpreter.

7. Click Execute to run the script and create the repository tables. This may take several
minutes.

Note: If the installation fails due to network problems, insufficient disk space, or
permission problems, we recommend that you do not choose to ignore the errors, but rather
abort the installation and start again.

8. When the repository has been installed, the Change Password dialog will open, prompting
you to change the administrator password. Enter a password that complies with the default
repository password policy as listed in the dialog, and then click OK to complete the
creation of the repository.

In the repository Browser, the root of the repository tree displays the repository name and
the connected user and is ready for use.

Creating a Data Source to Access Your Database
In order for PowerDesigner to connect to your database, you must create a data source from
within PowerDesigner or using the ODBC Data Source Administrator.

The instructions given here are for creating an ODBC machine data source for SQL
Anywhere. For information about creating other data sources for other DBMSs, see Core
Features Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner >
Connecting to a Database.

Note: In order to create a data source on a Windows 7 machine, you may need to launch
PowerDesigner or the ODBC Data Source Administrator by right-clicking its icon or menu
item and selecting Run as administrator.

1. Click the Select a Data Source tool on the Repository Definition dialog, then select
ODBC machine data source and click Configure. On the ODBC Machine Data
Sources tab of the Configure Data Connections dialog, click the Add Data Source tool,
then select System Data Source and click Next.

Alternately, to create a data source using the ODBC Data Source Administrator, select
Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC),
select the System DSN tab, and then click Add.

Note: In a 64-bit environment, you must use the 32-bit version of the ODBC Administrator
tool, because PowerDesigner cannot connect to 64-bit ODBC DSNs (see Windows 64-Bit
Support on page 10).

2. Select SQL Anywhere 12 and click Next, and then click Finish to create the data source.
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3. On the ODBC  tab of the ODBC Configuration for SQL Anywhere dialog, enter an
appropriate name such as PD Repository in the Data source name field.

4. Click the Login tab and enter the following values:

Parameter Value

Authentication Select Database.

User ID Enter the administrator name you chose when creating the database (see 
Creating a Database to Contain the Repository on page 25).

Password Enter the administrator password you chose when creating the database.

Action Select the appropriate action:
• Start and connect to a database on this

computer
• Start and connect to a database on another

computer

Database file Browse to and select your database file.

Database name Enter an appropriate name such as PD Repository.

Server name Enter an appropriate name such as PD Repository.

Start line Enter "C:\Program Files\SQL Anywhere
12\Bin32\dbsrv12.exe" (including the quotation marks).

Stop database after
last disconnect

Deselect this option if you want the repository to continue to be available
after you disconnect from it.

5. Click OK to complete the configuration of the data source.

Troubleshooting the Repository Installed on ASE
This section lists known issues encountered when installing the repository on Sybase
Adaptive Server Enterprise.

Commonly Required ASE Parameters
The following ASE parameters must frequently be configured higher than their default
settings to optimize check in of models:

• number of open objects

• number of open indexes

• number of locks

• max memory

• procedure cache size
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Must declare variable '@dr_t_a0'. SQLSTATE = ZZZZZ
If you see the above error and are connecting to an ASE server via ODBC, open the ODBC
Data Source Administrator, select your data source, and select the Enable Dynamic Prepare
option on the Connection tab.

Truncated data on extraction
If you are seeing data truncated on extraction from the repository and are connecting to an
ASE server via ODBC, open the ODBC Data Source Administrator, select your data source,
and enter the value 10000000 in the Text size field on the Advanced tab.

If characters such as the ellipsis are being truncated, you should verify that the character set of
your driver matches the setting for your database.

Connection Profile: "Error converting characters into server's character set"
If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
Definition dialog, add the CharSet parameter, and enter the appropriate charset value to
match your repository database.

Troubleshooting the Repository Installed on DB2
This section lists known issues encountered when installing the repository on IBM DB2.

Exception During Search
If you are seeing exceptions when performing a search through the PowerDesigner Portal, you
should consider doubling the size of the applheapsz parameter, which controls the
application heap size.

Connection Profile: "Error converting characters into server's character set"
If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
Definition dialog, add the CharSet parameter, and enter the appropriate charset value to
match your repository database.

Troubleshooting the Repository Installed on SQL Server
This section lists known issues encountered when installing the repository on Microsoft SQL
Server v2005 and higher.

Optimizing Repository Reads with Snapshots
To ensure that all users reading data will get access to a snapshot and not be blocked by
concurrent transactions, we recommend that you enable the following SQL Server options:

• ALLOW_SNAPSHOT_ISOLATION
• READ_COMMITTED_SNAPSHOT
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Note: No users should be connected to the repository when you enable these options.

Connection Profile: "Error converting characters into server's character set"
If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
Definition dialog, add the CharSet parameter, and enter the appropriate charset value to
match your repository database.

Installing the Repository Proxy
The PowerDesigner repository proxy is an optional program that runs as a service on or near
the repository server and translates SQL requests from client workstations into a more
efficient proprietary format. The proxy can considerably improve performance, particularly if
clients will be connecting over a WAN or complicated LAN environment or when dealing
regularly with larger (15MB+) models, due to its client request pooling and sophisticated
caching.

Using the proxy also simplifies the client connection to the repository, as users do not need to
know details of the database hosting the repository.

1. Choose whether to install the repository proxy on the repository server, or on another
windows machine on the same LAN.

You should install the proxy on the same server as the repository, if possible, to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing the proxy
on another machine on the same LAN segment. We recommend as a minimum, a dual-core
machine, with 2-4GB of RAM, but the exact system requirements depend on the number
of concurrent users and the size of your repository.

2. Create a system data source on the chosen machine to define the connection between the
proxy and the repository database (see Creating a Data Source to Access Your Database on
page 28).

3. Insert the PowerDesigner software CD-ROM in the drive, and then click the Install
PowerDesigner Repository Proxy button.

4. Click Next to go to the license agreement page. Select the location where you are installing
the software, read the License Agreement, and then click the I Agree radio button to accept
the terms of the agreement. If you click I Do Not Agree, you cannot proceed with the Setup
program.

Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

5. Click Next to go to the directory selection page. Accept the default installation directory or
choose another by clicking the Browse button.
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6. Click Next to go to the current settings page to review your choices, and then click Next to
start copying files.

When setup is complete, a page is displayed with two checkboxes selected by default, to let
you start the proxy service and launch the configuration tool.

7. Click Finish to exit the wizard and open the Proxy Configuration dialog.

Note: You must have write access on HKEY_LOCAL_MACHINE to change proxy
parameters. On a Windows 7 machine, you may need to launch the Proxy Configuration
dialog by right-clicking its icon and selecting Run as administrator. You can open the
configuration dialog at any time by navigating to the proxy installation directory and
launching pdproxyconf16.exe.

8. Click New to create a new proxy connection instance, and enter the following parameters.

Parameter Value

Instance name Enter an appropriate name to identify the instance.

Data source Select the system data source you created for the repository from the list.
Note that the proxy cannot access user data sources.

User name Enter the user name used to connect to the repository database.

Password Enter the password used to connect to the repository database.

Bytes per char For non-Oracle unicode or multi-byte character set databases, specify the
bytes per character used by the database:
• 1-byte - [default] For SBCS (Single-Byte Character Set)
• 2-byte - For DBCS (Double-Byte Character Set)
• 3-byte - For Unicode or MBCS (Multi-Byte Character Set)

Port Enter the connection port of the server on which the proxy is installed and
which allows the client to communicate with the server using TCP/IP pro-
tocol. The default port number is 32999.

Log file Select the level of logging that you want to perfom and enter or browse to the
path to the log file in the Name field.

Cache Enter or browse to the path to the cache, and specify its maximum size. The
default is 300MB, which is generally sufficient for optimum proxy per-
formance.

Note: A single proxy server can provide simultaneous connections to multiple
PowerDesigner repositories of the same version. Click the New button to create an
additional instance.

9. Click OK to complete your definition of proxy instances.

Users can now connect to the repository via the proxy by specifying the server name, port
number and instance name in a proxy repository definition (see Core Features Guide >
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Modeling with PowerDesigner > Getting Started with PowerDesigner > Accessing the
Repository).

Installing the PowerDesigner Portal Server
The PowerDesigner Portal allows you to view the contents of your repository in your standard
web browser. The PowerDesigner installation disc includes database access and web
application layers that are required to browse your repository from the web, along with a
standard Apache Tomcat web server. Before beginning the installation, you should already
have created your repository database and have the DBMS user name and password to hand.

For maximum responsiveness, we recommend that you install the database access layer on the
same machine as your repository database, while the web application layer can be installed on
any appropriate machine. While each instance of the PowerDesigner Portal database access
layer can only communicate with a single repository database, a single web application
instance can communicate with multiple database access layers and provide a single point of
access for users browsing multiple repositories.

If the repository server is not a Windows server or is unable to support the additional workload,
then we recommend installing the PowerDesigner Portal on another machine on the same
LAN segment. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on the number of concurrent users and the size of your
repository.

Note: For information about using the PowerDesigner Portal, see Core Features Guide >
Storing and Sharing Models > The PowerDesigner Portal.

1. Insert the PowerDesigner software CD-ROM in the drive, and then click the Install
PowerDesigner Portal  button.

The PowerDesigner Portal installation program opens to the welcome page.

2. Click Next to go to the license page, and select the type of license that you want to use:

• Trial - For evaluating PowerDesigner and the PowerDesigner Portal
• PowerDesigner Portal - For using the PowerDesigner Portal without allowing users

to edit object comments, descriptions, and annotations
• PowerDesigner Portal Composer - For allowing users to edit object comments,

descriptions, and annotations, which requires a separate license. If you select this
option, you will be prompted to specify the licence server that manages this license (see
Installing a License Server on page 4).

3. Click Next to go to the license agreement page, and select the location where you are
installing the software. Read the License Agreement and click the I Agree radio button to
accept the terms of the agreement. If you click I Do Not Agree, you cannot proceed with
the Setup program and you will have to cancel the install.
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Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

4. Click Next to go to the web server page. If you have already installed one or more
PowerDesigner Portal servers, you can select the second option to install the web
application layer only. You will then be prompted to specify connection information for a
PowerDesigner Portal server to which it will connect. Setup suggests a location in which to
install the PowerDesigner Portal, which you can change by clicking the Browse button.

5. Click Next to go to the application server page. By default, the installer will install a new
Tomcat Server. If you want to use one of the other supported servers, select it and specify
its location. Default sever ports may be provided that you must verify. At least one port is
required in order to create a connection profile and connect to the repository database.

Note: If you choose the WebLogic application server, you must deploy the archive
directory (by default, the weblogic_openfolder directory inside your
PowerDesigner Portal installation directory) from your WebLogic Administrative
Console once the setup has completed.
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6. Click Next to go to the JDK page. By default, a new JDK is installed. If you want to use an
existing JDK, deselect the check box and specify its location.

7. Click Next to go to:

• [for a full PowerDesigner Portal server install] The database parameters page lets you
enter the appropriate parameters for your database. If you select the Use Windows
Authentication checkbox, you will need to select the This account option on the Log
On tab of the web server service property sheet before starting the service.
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• [for an application layer only install] The connection information page of the
PowerDesigner Portal server lets you enter the appropriate parameters for connecting
to the existing repository web server instance. You must enter at least one port:
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8. Click Next to go to the information page which summarizes your choices.

9. Click Next to accept the current settings and start copying files.

The install begins. A progress box is displayed and Setup copies files to the destination
directory. When the setup is complete, one of the following pages appears depending on
your selection on the web server page:

• [PowerDesigner Portal server] The completion page opens with two check boxes
selected by default to let you:
• Start the PowerDesigner Portal Server service
• Open the PowerDesigner Portal Web page

• [web application layer] The completion page opens with a check box selected by
default to let you open the service configuration page and enter its account name and
password. Then you will have to start the service.

10. Click Finish to exit the wizard.

Accessing the PowerDesigner Portal Web Site
You can start and stop the PowerDesigner Portal server and the associated service by
navigating to the server from your Start menu.

By default, these commands appear as sub-items of Programs > Sybase >  PowerDesigner
Portal , and selecting the appropriate sub-item:
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• Start the PowerDesigner Portal Server
• Start the PowerDesigner Portal Server Service
• Stop the PowerDesigner Portal Server
• Stop the PowerDesigner Portal Server Service

When the server is running (whether as a service or not), navigate to the following address:

http://server-name:port-number/cmr

Where server-name is the name of the machine on which you have installed the
PowerDesigner Portal server, and port-number is the port specified during installation. Note
that cmr is the name of the PowerDesigner Portal program and is a required part of the
address.

The following screen will appear:

For information about using the PowerDesigner Portal, see Core Features Guide > Storing and
Sharing Models > The PowerDesigner Portal.

Controlling SSL Encryption for the PowerDesigner Portal
All passwords saved in the repository configuration files are encrypted and are decrypted at
runtime. User passwords are encrypted when making connection to the repository.

The default keys used for the encryption and decryption process are saved in the following
file:

install_dir/keystore/common.keystore

For security purposes, we recommend that you generate your own key and keystore file. The
keystore information is saved in the following file:

install_dir/keystore/config/cmrcommon.xml
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This file contains the following XML structure:

<cmrcommon>
    <!-- Keystore Configuration -->
    <bean class="java.lang.Object" id="cmr.common.config.keystore">
        <!-- if value is empty, default to cmr home\keystore folder 
-->
        <param name="keyStoreFilePath" value=""/>
        <param name="keyStoreFileName" value="common.keystore"/>
        <param name="keyStoreAlias" value="cmrenkey"/>
        <param name="keyStorePassword" value="changeit"/>
    </bean>
</cmrcommon>

You can edit the following nodes:

• keyStoreFilePath – Specifies the path to the keystore file. Default value: install_dir/
keystore/.

• keyStoreFileName – Specifies the name of the keystore file.
• keyStoreAlias – [required] Specifies the name of the alias of the key in the keystore.
• keyStorePassword – [required] Specifies the password to read the keystore.

You can use the following command to generate a 512 byte key and keystore file:

JDK_HOME\bin\keytool -genkey -keyalg RSA -keysize 512 –alias 
keyStoreAlias -keypass keyStorePassword -keystore keyStoreFilePath
\keyStoreFileName -storepass keyStorePassword

For example: to generate a new key using the default values specified in the cmrcommon.xml
file:

JDK_HOME\bin\keytool –genkey –keyalg RSA –keysize 512 –alias 
cmrenkey –keypass changeit –keystore install_dir\keystore
\common.keystore –storepass changeit

Note: All PowerDesigner Portal web application layer installations that need to connect to a
PowerDesigner Portal Server must use the same keyStore file.

Installing the PowerDesigner Portal Server on UNIX
We do not provide support for installing any component of PowerDesigner on UNIX.
However, it is possible to manually deploy the PowerDesigner Portal to a UNIX environment
using this procedure.

Note: This procedure requires that you install and configure the PowerDesigner Portal on a
Windows server in order to copy certain of the installation directories to your UNIX
installation.

1. On your UNIX server, install JDK 6.0 or higher, and set the JAVA_HOME environment
variable to its path. For example:

export JAVA_HOME=/usr/lib/jvm/java-6
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2. Install Tomcat 5.5 or 6.0 and set the CATALINA_HOME environment variable to its path.
For example:

export CATALINA_HOME=…/apache-tomcat-6.0.28

3. Create a new folder called CMR, and set the CMR_HOME environment variable to its path.
For example:

export CMR_HOME=…/CMR

4. Copy the contents of the CMR_HOME directory on your Windows environment to the
CMR_HOME directory on the UNIX server.

5. Extract the appropriate license library for your flavor of UNIX from CMR_HOME/
license/lib/sylapi 2.2.0.7.zip to CMR_HOME/license/lib.

6. Copy the cmr.war file from the CATALINA_HOME/webapps directory on your
Windows environment to the CATALINA_HOME/webapps directory on the UNIX
server.

7. Unzip cmr.war and edit the file cmr.war/WEB-INF/cmrhome.xml to remove the
content of the Path element, so that it reads <entry key="Path"></entry>.
Rezip cmrhome.xml into a new cmr.war and deploy the new cmr.war.

8. Ensure you have installed the necessary JDBC drivers to connect to your PowerDesigner
Repository, and that they can be found via the proper path statement.

9. Run CATALINA_HOME/bin/startup.sh.

Multiple PowerDesigner Portal Instances on One Server
We do not provide support for running multiple instances of the PowerDesigner Portal on a
single physical server. However, it is possible to manually configure your installation to do so
using this procedure.

1. Install the initial PowerDesigner Portal normally.

In this example, we will install the Portal to C:\Portal:

2. Create a second installation directory for the second instance of the Portal, and add a sub-
directory to hold the second instance of Tomcat.

In this example, we will create a second installation directory at C:\Portal2

3. Install the second Tomcat or other server to C:\Portal2\Tomcat and specify a
different listening port.

In this example, we will use port number 3030 for the first Tomcat and 9090 for the second
instance

4. Copy C:\Portal\Tomcat\webapps\cmr.war to C:\Portal2\Tomcat
\webapps\cmr.war. For the remainder of this procedure, the file must be unzipped, as
it will be if Tomcat is running.
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5. Copy the folders config, log, keystore, and license from C:\Portal to C:
\Portal2.

6. Edit C:\Portal2\Tomcat\webapps\cmr\WEB-INF\cmrhome.xml to
specify your new folder:
<entry key="Path">C:\Portal2</entry>

7. Clear C:\Portal2\Tomcat\work and restart Tomcat.

The URL for accessing the first PowerDesigner Portal is http://myserver:3030/
cmr/ and the URL for the second is http://myserver:9090/cmr/.

The new instance will initially point to the original database. You can change the database:
• By clicking the Advanced options link on the login page.
• By editing C:\Portal2\config\repository.xml

Changing the Repository DBMS
If you decide to change the DBMS on which the repository database is stored, then you must
copy an appropriate JDBC driver to the PowerDesigner Portal 16\Tomcat
\webapps\cmr\WEB-INF\lib directory to allow the PowerDesigner Portal to connect
to the new database.

We recommend that you keep your original database running initially and that you change the
parameters on the PowerDesigner Portal Server Settings page, and use the Test Connection
button to confirm that you can connect to the new database.

Upgrading the Repository
When an administrator upgrades their PowerDesigner client and then connects to an existing
repository for the first time, they will be prompted to upgrade the repository. Until an
administrator upgrades the repository, other users who have upgraded their PowerDesigner
client will not be able to connect to the repository.

Warning! Always back up your repository database before upgrading it. Upgrading the
repository typically creates many log entries, and you should consider increasing the log size
to accommodate them.

1. If you have installed the PowerDesigner Portal, you must stop the PowerDesigner Portal
Service before upgrading the repository.

2. Open PowerDesigner and select Repository > Connect to open the Connect dialog.

Only the PowerDesigner modules that are installed on your machine will be upgraded in
the repository database. For example, if you do not have the Object Oriented Model
installed on your machine, that part of the repository database will not be upgraded. For
this reason, you should try to perform the upgrade from a machine that has all of the
modules used by your organization installed.
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3. Select a direct repository definition from the list, enter your password, and click OK.

Note: Upgrading the repository via the proxy is not supported.

4. You are prompted to update the repository. Click Yes to continue and open the Repository
Update Script dialog.

Depending on the size and complexity of your repository, this dialog may take several
minutes to appear.

Note: If you created your repository database with Microsoft SQL Server or Sybase ASE
before PowerDesigner version 15.0, we recommend that you select Rebuild clustered
indexes in this dialog to improve performance, particularly for document check out. If you
do not select this option at upgrade time, you can select Repository > Administration >
Rebuild Clustered Indexes at any time to perform the rebuild.

5. Click Execute to begin the repository upgrade.

The upgrade may take some time to complete. In the event of an upgrade failure due to
network or permission problems, or insufficient disk space, you should restore the
repository database from your backup version and retry an upgrade when problems are
solved. If the upgrade fails because of the data in your database, then you should contact
technical support for assistance.

6. [when upgrading from a repository before v16.1] If your repository contains branches, you
are prompted to update your branches to the new implementation (see Post-Upgrade
Cleanup for a Repository Containing Branches on page 43). Click OK to continue.

Note: Depending on the complexity of your branch structure and the size of your
repository, upgrading your branches may take a considerable time. If you click Cancel at
this point you will leave the repository in a stable state, and can relaunch the upgrade at a
later point by reconnecting to the repository.

7. [when upgrading from a repository before v16.1] If your current password does not
comply with the default repository password policy, you will be prompted to change your
password. Enter your new password (which must comply with all the rules listed in the
dialog) and then click OK.

Note: Administrators can control the restrictiveness of the password policy (see Core
Features Guide > Administering PowerDesigner > Controlling Repository Access >
Defining a Password Policy).

8. The Library Synchronization dialog opens to prompt you to synchronize the contents of
your local library. Make any appropriate selections and click OK to perform the
synchronization and complete the repository upgrade.

For information about administering the library, see Core Features Guide > Administering
PowerDesigner > Deploying an Enterprise Glossary and Library.
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Post-Upgrade Cleanup for a Repository Containing Branches
The new implementation of repository branches provides many improvements over branches
in v16.0 and earlier, but if your existing repository contained branches, you may want to
perform some post-upgrade cleanup of your updated branch structure or create a new
repository and migrate all your active documents to it.

For v16.1, branches in the repository have been completely re-architected to allow:

• The simultaneous display of all branches in the repository browser.
• Branching on a folder-by-folder basis.
• Simplified version numbering.
• Greater flexibility and control over branch contents.
• Simplified integration of changes from one branch to another.

During the repository upgrade, PowerDesigner will transform any existing branches in your
repository to the new format, and your new repository will display all of your old branches as
siblings directly under the root. As a result, you may experience the following issues:

• Too many branches at root making the repository difficult to view and navigate. To
simplify your repository, you should consider:
• Hiding branches when they are not needed for certain users.
• Deleting old branches that are no longer needed for any users.

Note: For information about working with the new repository branches, see Core Features
Guide > Storing and Sharing Models > The Repository > Branching Version Trees.

• The presence of branches at the root prevents you from being able to branch sub-folders
(because you cannot create a branch under another branch).

To simplify a repository and enable the creation of branches on a folder-by-folder basis, you
should create a new repository and transfer all your appropriate models and other documents
to it.

1. Review your existing repository and identify the models and other documents that are still
current and that you want to transfer to your new repository.

2. Create a new repository and create all the necessary users and groups in preparation for
allowing your users to connect to it.

3. Set up an appropriate folder structure to allow you to organize your documents by project,
and in preparation for future branching.

4. Connect to your old repository and check out all the documents you want to transfer.

Note: To ensure that no changes are lost, you may want to perform the remaining steps
outside of normal working hours or instruct your users to terminate their connections with
the old repository and await permission to begin connecting to the new repository.

5. Connect to your new repository and check the documents to transfer into it.
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Note: When you check documents into the new repository, their revision histories will not
be transferred with them. For this reason, you may want to retain, at least for a time, your
old repository to give you continuing access to this information.

6. Continue transferring documents until everything that you need for ongoing development
is in the new repository and organized in an appropriate folder structure.

7. Communicate the new repository connection information to your users and instruct them
from now on to only check documents in and out of the new repository.

Deleting the Repository
You can delete the repository by using the Drop Repository Tables command, which
removes all repository tables and their content from the database and cuts the connection with
the database. You cannot drop the repository tables through a proxy connection. You must
perform a direct ODBC connection instead.

Warning! Dropping the repository database cannot be undone. If you have not backed up your
models and other contents, they will be lost.

1. Select Repository > Administration > Drop Repository Tables. You will be prompted
to confirm that you want to continue. Click Yes to open the Repository Table Drop Script
window.

This window is read-only. You can only review the script, and not edit it. If you want to
modify the script you should copy it to a script interpreter, after having selected the
appropriate separator for your interpretor from the list.

2. Click Execute to begin the deletion.
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